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Foreword

M odeling software is rapidly replacing traditional two-dimensional drafting software
as the vehicle for designers to create and communicate. SketchUp has emerged as the
modeling program of choice in many diverse fields as a result of its low price and relatively
shortlearning curve. This book is for the beginner who wants to get up and running with

it fast.

Why Read This Book?

You may be wondering why you should read a SketchUp book, when there is so much content
online. My answer is that the online content, while very good, is not organized. If you don’t
know what the software’s capabilities are, you don’t know what to ask or search for. This book
leads you through SketchUp in an orderly manner. Its intent is to acquaint you with its many
capabilities. Toward that goal, tools and functions are briefly described under their own
headings and then used in step-by-step examples.

SketchUp’s most popular functions are introduced early, to enable you to quickly do what
you want to do with it. Some tools are revisited later to show more complex options. By the
time you finish, you’ll have been exposed to most of the tools, one or two options for each,
and some different approaches for solving modeling problems. You’ll then be pointed to a site
where you can ask your increasingly complex questions. End-of-chapter links to high-quality
online content are also given as a guide through the ocean of Web information.

What's Covered?

Coverage is specific to the interests of interior designers and interior architects: how to model
interior spaces, study scale and proportion, test different ideas, present solutions, plan spaces,
and generate architectural floor plans, elevations, and sections. There are also examples

that show SketchUp combined with other software programs and hand-rendering tools for
maximum utility and flexibility.

Knowledge of other drafting software is not needed. However, it is assumed that the reader
has basic architectural drafting knowledge, such as what floor plans, interior elevations, per-
spective, and isometric and section views are. This book shows how to use SketchUp to create
those drawings; it doesn’t discuss what they are. If you could benefit from a drafting refresher,
some resources are listed at the end of this Foreword.

Since PCs are standard in the interior design and architecture fields, screenshots are from a
PC. Where operations on a Mac are different, Mac screenshots are added. Pro (the pay version
of SketchUp) is also discussed, because Pro is cheaply available to students and schools. While
all tools in Make (free) and Pro work in the same way, Pro has additional features needed in a
professional work capacity.
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Extra Goodies

On the Wiley site there are video tutorials of the book’s projects; look for the [D] symbol
on the page. There is also a Homework folder full of files for completing the end-of-chapter
exercises and recreating the projects yourself. Download and save the whole folder at once
to your desktop so everything will be available when needed. Instructors have an additional
folder with answers to the end-of-chapter questions, some project models, and high-resolution
images of SketchUp drawings for showing classes how SketchUp is used in the practice of
interior design and architecture.

So, let’s get started!

The site that contains the videos is: www.wiley.com/go/sketchupforinteriordesign

Further Resources

Cline, Lydia Sloan. Architectural Drafting for Interior Designers. Clifton, NY: Cengage, 2007.

Cline, Lydia Sloan. Drafting and Visual Presentation for Interior Designers. Upper Saddle River,
NJ: Prentice Hall, 2011.
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What Is SketchUp

and How Do Interior
Designers Use It?

What Is SketchU p'_? Objective: This chapter discusses
what modeling is, what SketchUp

SketchUp is a polygonal surface modeling program (Figure 1-1). Y G O et Oy ot

Polygonal means that everything SketchUp creates is made out

of polygons (flat shapes bordered by straight lines). Surface designers.

means that everything it makes is hollow. Modeling means that Concepts and Functions: SketchUp

it makes models, which are three-dimensional (3D) digital Make, SketchUp Pro, model, solid/

drawings composed of lines and faces (planes). Collectively, surface/wire/polygonal model,

those lines and faces are called geometry. polygon, geometry, vector, raster,
SketchUp is also a vector program, meaning it creates vec- BIM, attributes, dynamic compo-

tor files with an skp extension. A vector file is a collection of nent, reports, solid modeling tools

lines and curves that scale up or down without loss of quality.
Examples are pdfs (Adobe documents) and dwgs (AutoCAD doc-
uments). This is as opposed to a raster file, which is made with
individual pixels and loses resolution quality when enlarged.
Examples are jpgs and gifs.

SketchUp is strictly a desktop application, not a Web-based
one. It works on both the PC and the Mac. Files made on one
platform transfer easily to the other.

Figure 1-1: All SketchUp models, including circles, are made of polygons and
are hollow.
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Who Uses It?

SketchUp was written as a user-friendly alternative to the complex modeling software
common in the architectural field, its original user base. Previous owner Google made it free to
the public, which wildly expanded its popularity beyond the original architect user base. Now
interior designers, game developers, filmmakers, woodworkers, catalog illustrators, packaging
designers, landscapers, and more use it too.

Is It Easy to Learn?

It’s probably easier than other industry-standard modeling programs, because it has fewer
features and is somewhat intuitive. But “easy” is relative. Like everything else, it still takes
practice—you probably didn’t make great pencil sketches right away, either.

Know that there are many ways to do the same thing in SketchUp, and no one “right” way.
Some ways take a few more steps, but if you make learning it the first priority, efficiency will
follow.

What Is SketchUp Used For?

SketchUp is used to electronically sketch ideas three-dimensionally—to “get your doodle
on.” It’s the closest you can get to pencil and tracing paper for thinking out ideas. Since
you can “sketch” loosely (meaning without inputting numbers), this software helps you
think spatially. Height/width relationships become easy to see; for example, a hallway
that seems wide in a floor plan may reveal itself as dark and narrow when the vertical
dimension is added. As with a physical foam-core model, a digital model can be studied
from any direction. However, SketchUp one-ups the foam-core model with camera tools
that let you stroll through the digital model at eye level. Finally, SketchUp models can
make the jump to the construction documentation process when the LayOut feature
are added.

SketchUp has evolved into two programs: a free, noncommercial one called Make and a
commercial product called Pro. Both are owned by Trimble, a company that makes positioning
technology products.

The Difference between Traditional CAD Drawings
and Models

With traditional computer-aided drafting software such as AutoCAD, the mouse is an
electronic pencil with which you basically replicate the hand-drafting process. Three-
dimensional (3D) drawings made with AutoCAD are really a collection of two-dimensional
(2D) entities that give the illusion of three dimensions. A model, however, is a true 3D
object that the viewer can “orbit” around and view from any position. Two-dimensional
(orthographic) views are generated from it (Figure 1-2).
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Figure 1-2: The user orbits around a model to view it from any position.
Two-dimensional (2D) views are then generated from it.

AutoCAD is not a prerequisite to learning SketchUp; the two programs operate differently.
If your computer drafting experience to date is limited to traditional 2D software, you will
find that modeling requires a different approach. You may also find that you never want to go
back to 2D software once you see the advantages of 3D.

How SketchUp Displays the Model

By default, SketchUp displays the model as a 3-point perspective. That is, all parallel lines
converge to left, right, and top or bottom vanishing points. However, it can be set to display
as a 2-point perspective, as an isometric (3D view in which parallel lines remain parallel), and
orthographically (plan, elevation, and section views).

Types of Models
It’s helpful to understand the different model types before you learn SketchUp, because this
may affect how you plan to use it. Knowing a software program’s strengths and limitations
affects the time spent on a piece and its resultant quality.

There are three types of models: solid, surface, and wireframe (Figures 1-3).
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Solid models are just that: filled solid inside. They
contain data such as interior volume, mass, and S
weight. This enables you to perform tasks such as
specifying a constant wall thickness or connecting
and curving adjacent edges. Solid model file sizes
are large, so they may run and regenerate slowly. 3ds
Max and form+Z are two solid modeling programs
popular with architects and interior designers.

Surface models are hollow with a thin skin, com-
posed strictly of lines and faces (planes). You can

data—e.g., area—is stored. A surface model doesn’t it
recognize geometry as specific features; for example,
where a solid model would recognize a staircase and
perform relevant calculations, a surface model just
sees the staircase as lines and faces. Surface models
are used when the designer is primarily concerned Figure 1-3: Solid, surface, and wireframe
with external form and appearance. Their file sizes models.
are generally smaller than those of solid models, so
they run faster. Besides SketchUp, another popular
surface modeling program is Rhinoceros 3D.

Wireframe models are the simplest. They only contain information about the object’s edges

create complex curves and forms, but only surface ﬁ,

and intersections. As the name implies, this model appears constructed from wires. Its file size
is very small; hence, it runs quickly. Wireframes can be created or displayed with any modeling
software.

BIM, or building information modeling, refers to a particular, data-rich type of solid model
plus a collaboration process. A popular BIM program used in the construction industry is
Revit.

No model type is “best”; all have unique advantages. For example, designs that require a
constant wall thickness are better drawn with a solid modeler. Designs that require curved,
sculpted surfaces are better drawn with a surface modeler.

Older and newer versions of SketchUp can work on the same computer, but Make and Pro
cannot. Only one can be installed.

What SketchUp Make (Free Version) Can Do

The free version of SketchUp can do almost everything the commercial version can, such as:
> Make complete interior and exterior models
> Add color, texture, shadows, and geolocation information

> Apply styles that simulate art media, such as pencil and watercolor
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Make, download, and edit components

Download and use dynamic components

Download and use plugins (add-on software)

Create (low resolution) raster files and animations of the model

Import raster files of floor plans to trace, and of real-world materials to apply

vV vV v v v Vv

Export the model to 2D image formats

Pro has additional features that working professionals need.

What SketchUp Pro Can Do

> Import AutoCAD (dwg) and Revit (rvt) files (Figure 1-4). This turns them into SketchUp
geometry, which enables precise modeling from existing floor plans (tracing a raster file
may be time saving but is not precise). Layers and blocks are also preserved.

> Export SketchUp models into formats that can be directly imported into AutoCAD or Revit.

> Create presentation boards and design documents from the model. This is done with LayOut,
a feature that installs with Pro as a separate program (Figure 1-5).

—:‘_\\E}s )%\\ ﬁx\i >\L L.jr —

—_— =
— T _

T

COURTESY MATTHEW KERR, I[IDA, ASAI, ZIMMERMAN ARCHITECTURAL STUDIOS, MILWAUKEE, W1

Figure 1-4: An AutoCAD floor plan imported into SketchUp Pro and partially modeled.
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Figure 1-5: LayOut enables you to create a design document from a model.

Make custom line weights and styles, giving the model a hand-drawn appearance (Figure 1-6).
This is done with Style Builder, a feature that installs as a separate program.

Export high-resolution animation and raster files. These are more suitable for printing and
presentation than the low-resolution files the free version is limited to.

Create and edit dynamic components. These are models programmed to store information
and perform specific actions (Figure 1-7). For instance, staircases can add steps when
height is adjusted, and cabinets can store price and parts information and open doors
with a click.

Perform additive and subtractive modeling tasks, or what engineers call Boolean operations.
This saves steps, making for a faster workflow (Figure 1-8).

Generate reports such as materials takeoffs (e.g., how much paint to buy based on the
area of walls in the model).

Receive upgrades, maintenance, and support on technical problems via e-mail and phone. Such
support is for installation and licensing issues, not tutorials on the software.
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Figure 1-7: Clicking on this dynamic cabinet component makes the door open to show
storage options.
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Figure 1-8: With solid modeling tools, a tenon is pushed into a block of wood, then pulled
away, revealing a clean mortise joint automatically created.

Purchase Pro

A single, nonexpiring license for Pro costs $590, which includes a year’s maintenance
subscription. Upgrading to new versions after one year costs $95. Offices can buy single-
user and network licenses. A single license installs SketchUp on any computer, but only one
canrun it at a time. With a network license, you pay for the number of seats or instances
desired (with a 50-seat minimum required for a first purchase). The software can be installed
on as many computers as wanted, and the license resides on a server. You can run as many
instances of SketchUp as you bought seats for. Network licenses can’t be used off-site because
SketchUp must detect the license before starting. Thus, if you wanted to bring a laptop to a
client presentation, a single-user license would be needed.

Purchase a Pro Educational License

Students enrolled at accredited schools can purchase a $49 educational version that expires
after one year. It is fully functional and doesn’t watermark images, but it doesn’t permit
commercial use. Upgrades during the license’s year are free. You can also repurchase the
license after expiration if still a student. Obtain it through SketchUp’s network of educational
resellers; see Further Resources at the end of this chapter.
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How Designers Use SketchUp
Following are examples of ways SketchUp can be used by interior designers and interior
architects, both by itself and as part of a larger workflow.
> Solidify a pencil-and-tracing paper floor plan by tracing over it, and then model the
traced plan (Figure 1-9).

Top
TOaEOs

==

Figure 1-9: Tracing an imported plan and then modeling from it.

> Import models of specific manufacturer catalog items and use them to space plan (Fig-
ure 1-10). This enables seeing if there’s enough room for the furniture before presenting

to the client. The SketchUp model scan serves as a ‘fit’ drawing.

Figure 1-10: Ready-made models of lkea furniture and rugs, downloaded free from the

3D Warehouse.

Chapter 1: What Is SketchUp and How Do Interior Designers Use It?




> Change the model style to give it an artsy look (Figure 1-11) and make high-resolution
PDFs for marketing materials.

Figure 1-11: Four of the many styles available in free SketchUp.

> Use a SketchUp model as an underlay over which to trace ideas and adjustments. Print
up plans and 3D views of the model, hand-color and scan, and then import them into
Photoshop for lighting and text enhancement (Figure 1-12).

> Show animations and slide show scenes of different options (Figure 1-13). This enables
clients to see how the design works before committing to it. Their favorite photos and
wall art can also be incorporated.

n SketchUp for Interior Design
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Figure 1-12: A SketchUp model was printed up and then used as an underlay for tracing and marker work.

Aerial View | Fireplace | Stairs | Kitchen | Living Room | Exterior Frant

0O®O0® S

Figure 1-13: Incorporate photos into the model. The tabs at the top are preset scenes of the house for a slide show.

> Send the model to hands-on clients who want to make suggestions directly on it. Since

the software is free, they can download it themselves and experiment with colors, mate-
rials, and appliances.

> Importimages of the textiles specified in the design to display in the model (Figure 1-14)

Chapter 1: What Is SketchUp and How Do Interior Designers Use It?




> Show models of case goods to the tradespeople
who will make them, enabling them to see
exactly what’s wanted. Then use the LayOut fea-
ture to make construction documents from the
model. LayOut can also make quick drawings for
bid and permit purposes.

> Maintain a library of manufacturer-supplied
dynamic cabinet components. Change the com-
ponents’ size and configuration as needed, and
get instant prices based on each option.

> Use Style Builder to give an “open to changes”look
to the drawings. This makes them appear less like
a finished product while also conveying a specific
personality and brand identification.
Interested? Come on over to Chapter 2, where we’ll
discuss what'’s needed to run SketchUp, put it on your
computer, and explore its workspace.

Figure 1-14: Textile pattern applied to a
drapery model.

Summary

SketchUp is a surface modeling program used by interior designers for space planning,
conceptual design, and client presentations. Users can think through an idea, study design
options, and present them creatively. SketchUp has a free version called Make and a
commercial version called Pro, which contains functions needed for professional work.

Further Resources

Buy an educational license for Pro here: www.sketchup.com/buy/eduresellers.html
Buy Pro (noneducational) here: https://store.sketchup.com/

Cline, Lydia Sloan. Drafting and Visual Presentation for Interior Designers. Upper Saddle River,
NJ: Prentice Hall, 2011.

Obtain a free eight-hour trial of Pro: www.sketchup.com/intl/en/download/index.html
The Official SketchUp Blog: http://sketchupdate.blogspot.com/

@SketchUp on Twitter

SketchUp on Facebook: www.facebook.com/#!/sketchup

SketchUp for Interior Design
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Getting Started

I n Chapter 1 we discussed what SketchUp is and saw ways
interior designers and interior architects can use it. Now we’ll
discuss what’s needed to run it, and peek at its workspace.

Hardware, Operating System, and
Browser Requirements

SketchUp is a graphics-intensive program. The more detailed
your model, the more processing power it needs. A late-model
computer and operating system is needed, specifically:

PC: Atleast 2+ GHz processor, 2+ GB RAM, 500 MB of avail-
able hard-disk space, and a 3D-class video card with 512+
MB of memory or higher. Video card driver must support
OpenGL 1.5+. SketchUp Pro requires .NET Framework ver-
sion 2.0.

Operating System: XP, Vista, Windows 7, 8, and the Inter-
net Explorer 7.0+ browser.

Mac: At least 2.1+ GHz Intel processor, 2 GB RAM, 500 MB
of available hard-disk space, 3D-class video card with 512+
MB of memory or higher. Video card driver must support
OpenGL 1.5+

Operating System: Mac OS X 10.7, QuickTime 7, and
the Safari browser. Boot Camp and Parallels are not
supported.

A keyboard and three-button mouse, with the third but-
ton a scroll wheel, is the easiest and most efficient way to use
SketchUp. A one-button mouse or laptop track pad is doable but
difficult. Three-dimensional modeling requires much more on-
screen movement than 2D drafting. A scroll wheel lets you make
that movement faster than clicking icons or keyboard shortcuts.
Mac users, your one-button mouse can be swapped with any
manufacturer’s two-button/scroll wheel mouse.

Chapter 2: Getting Started

Objective: This chapter discusses
what’s needed to run SketchUp,
how to download and open it,
and tours the workspace.

Concepts and Functions: three-
button mouse, video card, tablet
PC, graphics tablet, digital pen,
computer tablet, Space Navigator,
splash screen, workspace, menu
bar, axes, scale figure, origin, mea-
surements box, instance, viewer,
template, Photoshop, Dropbox,
Save, Save As, Save A Copy As, Save
As Template, backup files




P Ifyour scroll wheel doesn't orbit or pan, the mouse settings may need adjustment. PC users, go to
Control Panel>Hardware and Sound>Devices and choose Printer>Mouse. Mac users, go to
System Preferences>Keyboard and choose Mouse. Look for a middle click wheel setting. If this
option isn't there, you may need to install a more recent mouse driver.

The Video Card

The video card, also called a graphics card, is an electronic board inside the computer that sends
information to the monitor. The ones installed in most off-the-shelf PCs and Macs are for
general use, not the higher demands of modeling software. Hence, they display SketchUp
models with a low-resolution, jagged appearance. Stronger cards, such as the NVIDIA GTX
600 series, are made to handle modeling software’s demands. They’re typically installed in
the computers of college drafting labs and companies that make software models. Higher-
end, off-the-shelf computers such as the Dell Precision also have them. If your goal is to print
SketchUp models for construction documents and marketing purposes, and make animations
for presentations, consider the video card when buying or upgrading a computer.

Figure 2-1 shows screenshots made with a low-end and high-end video card. Most of the
figures in this book were made with a high-end one. You might try to discern which ones
weren't.

/

Figure 2-1: The left screenshot was made with a standard card;
the right with an NVIDIA GTX-620 card.

The Space Navigator 3D Mouse

A mouse option for both the PC and Mac is Logitech’s Space Navigator (Figure 2-2), designed
for modeling software. It works similar to a game joystick, combining SketchUp’s Zoom, Pan,
and Orbit navigation tools into one. It also tilts, spins, and rolls. The Space Navigator can be

used alongside the traditional mouse.
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Figure 2-2: The Logitech Space Navigator 3D mouse moves through the
model more efficiently than the traditional mouse, and can be used along-
side it.

Speaking of joysticks, you can actually use a Wiimote controller (remote from a Wii game)
as a 3D mouse, too. Free GlovePIE software needs to be installed to do this; see Further
Resources at the end of this chapter.

Use a Tablet PC

Although SketchUp was designed to work with a keyboard and mouse, there are some
alternatives. One is a graphics tablet (not the same as a computer tablet) and digital pen.
The tablet’s buttons can be programmed to perform multistep functions that otherwise
take multiple keystrokes to perform, and the pen may cause less wrist fatigue than a mouse.
Examples of graphics tablets are Wacom’s Graphire, Intuos, Cintig, and Bamboo. Pens and
graphics tablets are also useful with Photoshop, which some designers import files of their
models into for further development.

SketchUp can be operated in a limited manner on a Windows tablet PC. Third-party viewer
apps exist for the iPad, iPhone, and Android tablet (Figure 2-3). Those apps let you view, walk
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through, and even annotate the model. This is useful for an on-site presentation, e-mailing,
or opening from a Dropbox (online hosting) account. Adding PDF files generated from LayOut
can turn a tablet PC into a portable portfolio! But heavy-duty modeling is best done on a com-
puter with a keyboard and two-button/scroll wheel mouse.

Figure 2-3: A SketchUp viewer app on an iPad.

Download SketchUp Make

It’s time to point your browser to www.sketchup.com and download the program (Figure 2-4).
You'll be asked what you'll use it for—select Personal for the free version—and what your
specific interest, operating system, and e-mail are. The software downloads very fast, even
with a slow Internet connection.
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Our Products Buy | Commercial Interiors
Interior Design

Landscape Architecture
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Sales and Marketing ® Model anything in 3D.
Survey v * Share and download medels from SketchUp's 3D Warehouse.
[Email Address | | *Profession/interesx ]| * SketchUp Make is not licensed for commercial work.

Select your operating system: Windows =]

*l agree to SketchUp Make's license agreement I/

Send me SketchUp news and tips !

Figure 2-4: The SketchUp download process.

SketchUp installs in Windows Programs and Mac Finder/Applications. Three shortcuts
(Figure 2-5) automatically appear on the PC desktop. On the Mac, the SketchUp icons appear
in the dock. Right-click, select Options>Show in Finder, and then drag the three icons from
the Finder window to the desktop, if you want.
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SketchUp Style Buider LayOut 2013
2013 2013

# Finder File Edit View Go Window Help

o

Layout sketchup Style Builder

B SketchUp 2013

B B

LayOut SketchUp Style Builder

Options > Keep in Dock
Open at Login

s Show in Finder

Quit

Figure 2-5: On the PC, three shortcuts appear on the desktop after instal-
lation. On the Mac, the icons can be dragged from the Finder onto the
desktop, if desired.

By default you're given 8-hour trial versions of Pro, Style Builder, and LayOut. After 8 hours
of use (the clock isn’t ticking while the software is closed), Pro reverts to Make, and the other
two stop working.

Click on the SketchUp icon to launch. A splash screen appears (Figure 2—6). As an aside, it
has no exit buttons, so if you didn’t mean to open it, click ESC to cancel. At the bottom is a col-
lapsed window called Template. Templates are files with default settings, such as measurement
units. Click it.

The template window opens (Figure 2-7), showing multiple choices. Choose Architectural
Design — Feet and Inches. In this template, all length numbers entered will appear in a feet and
inch format. Every number you type means inches, so you don’t need to include the inch unit
("). But SketchUp recognizes dimensions in any format as long as you include their unit after
the number (e.g., mm, cm, m, or (') for the foot sign).

Finally, click Start Using SketchUp. Figure 2-8 shows the screen. Figure 2-9 shows the PC
and Mac menu bars and the Getting Started toolbars right underneath. The menu bars are
slightly different; Mac users, note that yours starts with a SketchUp entry.
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Welcome to SketchUp

B SketchUp Make

Licensing Status: Non Commercial
Pro 2013 Evaluation Time Remaining: 7.97 Hours

Default Template:  Architectural Design - Feet and Inches

New to SketchUp? These tools are a great way to get started:

Rectangle Push/Pull

.

Draw a rectangle on the ground Extrude 2D faces

into 30 shapes.

Change
point of

For more help with lect Window > Instructor from the menu.

Figure 2-6: The splash screen with the collapsed Template window at the
bottom.

SketchUp

B SketchUp Make

Licensing Status: Non Commercial
Pro 2013 Evaluation Time Remaining: 7.77 Hours

Default Template:  Architectural Design - Feet and Inches

» Learn

» License
v Template
Template Selection: &)

Architectural Design - Feet and Inches
Units: Inches

| Thistemplate is for architectural and nterior design.

Simple Template - Feet and Inches
Units: Inches
This is 3 general user modeling template with basic styling and simple colors.

Simple Template - Meters
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This is a general user modeling template with basic styfing and simple colors.

Architectural Design - Millimeters
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| Thistemplate is for architectural and interior design.

Figure 2-7: Choose the Architectural Design — Feet and Inches template.
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Menu Getting Started toolbar
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Scale figure
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: selected entities
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= |

\

[o @ © (@) | select objects. Shift to extend select. Drag mouse ta select multiple. | Measurements | Y

\ Four circled symbols \ Measurements box
Figure 2-8: The SketchUp screen.
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Figure 2-9: The PC and Mac menu bars.

) The Workspace

The workspace contains:

The menu bar: This is a horizontal bar at the top of the screen that houses tools and func-
tions. It has eight categories: File, Edit, View, Camera, Draw, Tools, Window, and Help.

P File: Contains functions that let you open, save, print, import, and export files.

P Edit: Contains standard cut, copy, and paste functions plus SketchUp-specific ones
such as making groups and components.
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